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Read This Before Using the Camera

SAFETY INSTRUCTIONS

Do not drop, puncture or disassemble the camera.

Use the camera with care. Rough handling may damage the internal components.

Do not expose the camera to high temperature. Avoid contact with water.

Please notice that the camera body may become warm when operating it for an extended period.
Test for proper operation before using the camera.

Only use accessories supplied by the manufacturer.

Use only the type of battery that came with your camera.

Remove the battery if the camera is not going to be used for long periods.

Product Information

Designs and specifications of the camera are subject to change without notice. This includes primary
product specifications, software, and this user’s manual.

This User’s Manual is a general reference guide for the camera.

The illustrations in this manual may not be the same as the actual design of your camera and those
you see on the LCD screen.
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Section 1
Getting to Know Your Camera

Overview

The camera equipped a 5 Mega Pixel sensor that can take H.264 format videos. The H.264 technology
allows for extanded video recording with less memory. High quality images up to 16 mega-pixels can
also be delivered smoothly. With a color LCD monitor, you can view and examine the videos and photos
easily.

The camera features 3” (16:9) LCD touch panel which is an ideal platform for you to operate your
camera. The menu options are accessible with your finger. With the touch panel, you can select the
options directly and quickly.

The camera also features video recording at an HD resolution of 1920x1080. You can also connect it to
an HDTV via an HDMI cable, and easily playback the recorded high-definition videos on the wide screen
HDTV.

Moreover, the camera has an advanced uploading feature. With the exclusive built-in Internet Direct
application, you can upload the videos captured by the camera to the web site more effortlessly .

ISO sensitivity and color balance can either be adjusted automatically or changed manually. A 120x
digital zoom helps you to control over the videos and photos you take.

The varied effect options, such as Time Lapse and Slow Motion, make recording more fun.

The built-in memory allows you to take photos and to record videos without a memory card. The memory
card slot allows users to increase the storage capacity.

Note

» Partial memory of the built-in memory is used for the camera’s Firmware code and software.

.v/

* Install the bundled software application on the CD, ArcSoft Medialmpression, for viewing the
videos correctly on a PC.

Standard Accessories

Unpack the package and make sure all standard accessories listed are included:

+ Camera

+ USB Cable

* AV Cable

+ HDMI Cable

* Adaptor

« Lithium-ion Rechargeable Battery

* Quick Guide

* CD-ROM (Software, User’s Manual)
* Pouch

* Lens Cover Set (Lens cover and Strap)
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Front View

Tele/Wide Button

Photo Button

Microphone

LCD Touch Panel

Self-timer LED

Rear View
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Side View

Power Button
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b Playback Button

Pause Button
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Speaker Digital Light Button Stabilization Button

Bottom View
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Tripod Socket Battery/SD card Cover
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Section 2
Getting Started

Loading the Battery

Before using the camera, you must load the Lithium-ion
rechargeable battery come within the package.

1. Insert the battery according to the correct polarity marks ( + or
_)_

2. Close the battery cover firmly.

Charge your battery

You must use the supplied AC charger or the USB cable. The camera must be
turned OFF. The blinking light confirms the camera is currently charging, and
the light becomes constant after the charging is completed. In AC charging i
Mode, the light will turn itself off automatically after 3~5 minutes . The full
charge time is about 4 to 5 hours. (Actual charging time may vary. It depends
on the battery conditions.)

Inserting and Removing an SD Card (Optional)

The camera comes with an internal memory that allows you to store
photos and videos. You can expand the memory capacity by using an
optional SD memory card.

1. Insert the memory card into the slot. Please refer to the figure on
the right side.

2. To remove the installed SD card, press the card inward to release
it.

3. When the card pops out, gently remove it from its slot.

4. Recommended memory capacity: 1GB or above.

- 5 Note
¥« When a memory card is fitted, videos/photos are saved to the card rather than the built-in
memory.

* Protecting Data on an SD Card: SD Card is read-only LOCK & LOCK
when it is locked. No photos or videos can be recorded I_I
when the SD card is locked. Make sure the lock is on Writeable Write-Protected
the writeable position before recording any media. position Position
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Turning the Camera On

¢ To turn on the camera:

1. Flip out the LCD panel; the camera will turn on automatically.

2. Or press [Power Button] for approximately one second to turn it on.

Configuring the Initial Date and Time Setup

* The time setting screen appears to allow you to setup date and time:

Operation

Display Screen

Touch Year, Month, Day, Hour, Minute, and AM/PM to set.
Adjust the numeric value by touching . / .
Touch the [OK] icon to validate the setting.

Touch the Exit icon ( m ) to exit.

W bh =

2010 Al 07 | 02

09 : 30 AM

Getting Started

» To record video: Press [Video Button] to record video. To stop recording, press it again.

» To pause recording: Press [Pause Button] to pause recording. To continue the recording, press it

again.

» To take a photo during video recording: When recording video, press [Photo Button] to capture the

image. The Dual record icon ( a ) appears on the LCD monitor.

» To take a photo: Press [Photo Button] halfway down until the focusing frame turns from white to green.

Then, press it fully down to take photo.

I =1 - =1
[ | = |
i i
Focusing Frame: White Focusing Frame: Green

» To view stored videos and photos: Press [Playback Button] or touch
the Playback mode.

Turning the Camera Off

[®]| on the screen to switch to

» To turn off the camera: You can either press [Power Button] for one second, or you can place the LCD

panel back to its original position.
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Button Function

Section 3
Enjoying the Record Mode

Video Button:
1. Press to take video.

2. To stop recording, press it again.

PHOTO

Photo Button:
1. Press to take photo.

2. When recording video, press to capture the image.

w T

Tele Button:
1. Zoom In.
Wide Button

1. Zoom out.

Power Button:

1. Press down for one second to turn on or turn off the camera.

O=

Playback Button:
1. Switch between Record / Playback Mode.

2. For quick review, press it after recording.

O

Pause Button:
1. Press to pause the recording.

2. To continue the recording, press it again.

Digital Light Button:
Digital Light On/Off.

Stabilization Button:
Stabilization On/Off.
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LCD Monitor Information

The indicators shown below may display on LCD when videos and photos are recorded:

20

7063

@@

O 000D PRD®

(1)

Video Resolution

UFHD Full HD (1080p 30 fps)
UHD+ HD (720p 60 fps)
UHD HD (720p 30 fps)
VGAl VGA (640X480)

i

Slow Motion (Record video at 432x240(QVGA) resolution.)

Photo Resolution

(2)

&) 16MP
5MP
3MP
000530 Recording time of the video that can still be taken at current

resolution

Number of images that can still be taken at current resolution

()

7
O

Self-timer enabled

O

Dual Record

(4)

&)

Playback Mode On

()

Menu On

(6)

i

Information bar On

(7)

SD Card Inserted

10
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(8)

Flash Auto (Photo Recording Only)

Red Eye Reduction (Photo Recording Only)

Flash Off

(9)

Digital Light On

(10)

Stabilization

(11)

Pre-Record Mode

Time Lapse

=
)
A

Smile Detection

(12)

Macro Focusing On

(13)

Daylight

Fluorescent

| Bl [ < 3

Tungsten

(14)

Scene

Skin

™| D

Night

Backlight

Black/White

Classic

Negative

(15)

Date Printing On

(16)

Battery: full power

Battery: medium power

Battery: low power

Battery: empty power

DC power mode

(17)

Motion Detection

(18)

—==¥|LJ|0(B|§] &| = ==

Zoom meter:
1X~2700X (23X Optical zoom and 120X Digital zoom)

1
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'+ Note
F‘J L]

Stabilization, Time Lapse, and Slow Motion functions can not be used simultaneously.

 Stabilization and Night Mode functions can not be used simultaneously.
* Pre-Record, Motion Detect, Slow Motion, and Time Lapse functions can not be used
simultaneously.

Video Recording

» Press [Video Button] to start recording. When a video is being recorded, a time indicator will display
on the LCD monitor ( @ oo:00:25 ). To stop recording, press it again.

» To pause recording: Press [Pause Button] to pause recording ( [00:00:36 ). To continue the recording,
press it again.

» Dual record: press [Photo Button] to capture the image.The Dual record icon( a ) appears on the
LCD monitor.

« Press [Playback Button] or touch [[®]

» Four resolution settings are available:

on the screen to view the recorded video.

Video Quality

D
y FHD)

Full HD (1080p 30 fps)

-
4=

yHD+

HD (720p 60 fps)

D
gHD|

HD (720p 30 fps)

[VGA

VGA (640X480)

Note

» The image resolution captured during video recording is the same as the video resolution.

» The flash can not be used when capturing image during movies recording.

Photo Capturing

» Press [Photo Button] halfway down until the focusing frame turns from white to green. Then, press it
fully down to take photo.

« Press [Playback Button] or touch |[®]

» Three resolution settings are available:

on the screen to view the photos.

Image Quality

€]

16 Mega Pixels

5 Mega Pixels
3 Mega Pixels

Using Zoom Function

» The zoom magnifies images when recording video or taking photo.

1. To zoom in/out, press the Tele/Wide Button.

2. It can be set from 1X~2700X (23X Optical zoom and 120X Digital zoom)

EN
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Using Digital Light Function

» The setting allows you to extend the brightness of the objects that are dark or in the shadow. It can
extend the dynamic range for backlight and high contrast sense, so that the objects will be brighter

and clearer.
» To use the Digital Light function:

s0.

1. Press [Digital Light Button] in Record Mode. The Digital Light icon( s@' ) appears on the LCD
monitor.

2. Press [Video Button] to start recording or press [Photo button] to take photo.

Using Stabilization Function

» To record with an effect of reducing camera shake to result in more stable video.
» To use the Stabilization function:

1. Press [Stabilization Button] in Record Mode. The Stabilization icon( @)) ) appears on the LCD
monitor.

2. Press [Video Button] to start recording.

Showing Information on the screen

« Touch the on-screen button to show or not to show the indicators on the LCD screen.

Operation Screen

o . . . 000580 b %
1. Touch| g | on the screen. The information bar will show on 00550 7L

the screen.

2. Touch again to hide all indicators.

o fo U Y =¥ @ = 5

3. Touch i to display the indicators.

3
]
| HD [00:05:30) 7
@
. |
===}
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Options for Record Menu

Video Photo Effect Setting*

* Resolution * Resolution + Scene + Sound

* Pre-record * Flash  WB(White Balance) [+ TV

» Motion Detect » Self-Timer * Macro Mode » Language

» Slow Motion » Smile Detect » Face Tracking + Time Setting

» Time Lapse + ISO » Date Printing
+ Format
» Default Setting

* Please refer to Section 5 for the detailed information about [Setting].

Operations for Record Mode

Operation

Display Screen

1. Touch on the screen in Record Mode. The menu
will show on the screen.

[ HD [00:05-30) e

o fi

2. Touch the option icons on the screen lightly with your
finger. The options are Video, Photo, Effect, and Setting.

3. The option submenu will pop up on the screen.

4. Touch to select the specific option you want to adjust. (
The selected option will be highlighted.)

5. Touch the Exit icon ( ) to exit.

14
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Video

Operation Display Screen

1. Touch E on the screen in Record Mode. The menu
will show on the screen.

2. Touch the [Video] icon on the screen. Submenu of Video ﬂ VS
will pop out on the screen.

3. The Video submenu contains 5 options-- Resolution, Pre-
record, Motion Detect, Slow Motion, and Time Lapse --for
you to adjust the camera settings.

Video Resolution

Four resolution settings are available.

* FHD (1080p 30):Record videos at 1920x1080p 30 fps resolution.
* HD+ (720p 60):Record videos at 1280x720p 60 fps resolution.

e HD (720p 30):Record videos at 1280x720p 30 fps resolution.

* VGA (640X480): Record videos at 640x480p 30 fps resolution.

Operation Display Screen

1. In the Video menu, touch the [Resolution] icon on the B
screen.

2. Touch to select the desired option.

3. Touch the Exit icon (@ ) to exit.

Pre-record

The Pre-record function ensures that you will not miss any critical recording opportunities. The videos
are recorded 3 seconds more before the [Video Button] is pressed.

Operation Display Screen

1. In the Video menu, touch the [Pre-record] icon on the oo} Pre-record

screen. ﬂ]

2. Touch to select [Off] or [On] ( x).
Touch the Exit icon ( [ ¥ ) to exit.

b Note
» Aim the camera at the subject and position it securely.
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Motion Detection

Record videos automatically when the camera detects a movement.

Operation Display Screen

1. In the Video menu, touch the [Motion Detect] icon on the
screen. ‘_ Motion Detect

2. Touch to select [Off] or [On] ( D). ﬂl
Touch the Exit icon (| Rl ) to exit. -
4. Camera will start to record video automatically if it detects

a movement. Stop recording if it does not detect a
movement.

w

Slow Motion

Record videos with slow motion effect. When the video is played, the playback time will be longer than
the actual recording time.

Operation Display Screen

Slow Motion
BHE S

1. In the Video menu, touch the [Slow Motion] icon on the
screen.

2. Touch to select [Off] or [On] ((:¥ZD CX3).
Touch the Exit icon ( ) to exit.

Note

» Pause function can not be used when Slow Motion function is activated.

Time Lapse

Record still images at specific intervals you can set and play them as one video file.
» Off: Disable Time Lapse.

» 1 Second.: Record one frame per second.

» 3 Seconds: Record one frame every 3 seconds.

* 5 Seconds: Record one frame every 5 seconds.

Operation Display Screen

1. In the Video menu, touch the [Time Lapse] icon on the I
screen. _

WM A E B
2. Touch to select the desired option.

3. Touch the Exit icon ( ) to exit.

Note

» Pause function can not be used when Time Lapse function is activated.

EN
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Photo

Operation Display Screen

1. Touch on the screen in Record Mode. The menu
will show on the screen.

2. Touch the [Photo] icon on the screen. Submenu of i]

Photo will pop out on the screen.

3. The Photo submenu contains 5 options-- Resolution,
Flash, Self-Timer, Smile Detect, and I1SO, --for you to
adjust the camera settings.

Photo Resolution

Three resolution settings are available.

* 16MP:Shoot photo at 4608 x 3456, 16MP quality.
* 5MP:Shoot photo at 2592 x 1944, SMP quality.

* 3MP:Shoot photo at 2048 x 1536, 3MP quality.

Operation Display Screen

1. In the Photo menu, touch the [Resolution] icon on the 7
screen.

: * %
2. Touch to select the desired option. ﬂ
3

Touch the Exit icon ( ) to exit.

Flash

This camera has three flash settings.

* Flash Auto: The flash fires automatically according to light conditions. Use this mode for general
photography.

* Red Eye Reduct. (Red Eye Reduction) :The pre-flash will fire to reduce the red-eye effect.

* Flash Off: The flash will not fire under any circumstances. Use this mode when taking photo in a
place where flash photography is prohibited, or when the subject is distant (beyond the range of the
flash).

Operation Display Screen

1. In the Photo menu, touch the [Flash] icon on the screen. Flash Off

2. Touch to select the desired option.
3. Touch the Exit icon ( ) to exit.

Note
The flash will be disabled automatically when the battery power is low ( D ).

17



Self-Timer

The self-timer allows you to take photos with a ten-second time delay. The self-timer light on the front
of the camera will also blink. The speed of blinking will increase just before the photo is taken.

Operation Display Screen

Self-Timer

1. In the Photo menu, touch the [Self-timer] icon on the
screen.
2. Touch to select [Off] or [On] ( Cx)).

) to exit.

Touch the Exit icon (

Smile Detection

Capture image automatically when the camera detects a smile.

Operation Display Screen

1. In the Photo menu, touch the [Smile Detect] icon on the

Smile Detect

screen.
2. Touch to select [Off] or [On] ( Cx)).

) to exit.

Touch the Exit icon (

18



ISO

The camera adjusts the ISO sensitivity of its images automatically. Four manual ISO sensitivity settings
are available. (800/1600/3200/6400). The larger the number is, the higher the ISO sensitivity is set to.
Select a small number to shoot a smoother image. Select a large number to shoot an image in a dark

location or to shoot a subject moving at high speed.

Operation

Display Screen

1.
2. Touch to select the desired option.
3. Touch the Exit icon (@ ) to exit.

In the Photo menu, touch the [ISO] icon on the screen.

ISO

Iomz
@

Note

The image may become noisy when the ISO number is large.

Effect

Operation

Display Screen

Touch on the screen in Record Mode. The menu
will show on the screen.

2. Touch the [Effect] icon on the screen. Submenu of Effect e
will pop out on the screen. m
3. The Effect submenu contains 4 options--Scene, White
Balance, Macro Mode, and Face Tracking --for you to
adjust the camera settings.
Scene

You can select the mode according to the scene condition.

Auto: Shoot without any special effect on the image.

Skin: Shoot with an effect that makes skin tones more natural.
Night: Use Night Mode for night scenes or low light conditions.

Backlight: You can take shots when the bright light is behind the subject.

Black/White: The image is converted to black-and-white.
Classic: The image is converted to a sepia look.

Negative: The image is converted as the negative of the normal.

Operation

Display Screen

In the Effect menu, touch the [Scene] icon on the
screen.

Touch to select the desired option.

Touch the Exit icon ( ) to exit.

Negative
<Y
s @O

Note

To avoid blurry photos, place the camera on a flat, steady surface, or use a tripod when taking

shots in the Night Mode.

19

EN



White Balance

The_lc%rlnera adjusts the color balance of images automatically. Three manual white balance settings are
available:

* Auto: The camera automatically adjusts white balance.

* Daylight: Under outdoor condition.

* Fluorescent: Under fluorescent light condition.

* Tungsten: Under tungsten light condition.

Operation Display Screen

1. In the Effect menu, touch the [White Balance] icon on : Daylight
the screen.

2. Touch to select the desired option. ﬁ g

3. Touch the Exit icon (| Rl ) to exit.

Macro Mode

You can select the mode for recording close-up video and photo.

Operation Display Screen

1. In the Effect menu, touch the [Macro Mode] icon on the & Macro Mode
screen.

2. Touch to select [Off] or [On] ((¥D CX3). @ m

3. Touch the Exit icon to exit.
u xiticon ([l ) to exi v oy

Face Tracking

The camera can detect human face(s) and focus on the face(s) automatically. This function can works
with video recording and photo capturing. It is wonderful for capturing beautiful portraits in backlight
situation.

Operation Display Screen

1. In the Effect menu, touch the [Face Tracking] icon on
the screen.

2. Touch to select [Off] or [On] ((¥D CX3). Y
> m

Touch the Exit icon (| gl ) to exit.

& Face Tracking

~'+ Note
f’)  When Face Tracking is activated, aim the camera at the human face(s). The focus frame(s) will
show on the LCD before the [Video Button]/[Photo Button] is pressed.

20



Button Function

Section 4
Enjoying the Playback Mode

The Buttons have the following functions in Playback Mode.

Video Button:
1. Switch to Record Mode.

w T

Tele Button:
1. Zoom In.
Wide Button

1. Zoom out.

O=

Playback Button:
1. Switch between Record / Playback Mode.

2. For quick review, press it after recording.

O

Pause Button:

1. In Video Playback Mode, press to pause the recorded video.

21
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LCD Monitor Information

Indicators on the LCD screen while in Playback Mode:

Video Playback Mode

Photo Playback Mode

o 0
g oeheo

000370005 é 000370005

=] |
O 6 0 0 6 0 © O 6 0 P 0

(1)

Video Resolution

UFHD! Full HD (1080p 30 fps)
UHD+ HD (720p 60 fps)
UHD HD (720p 30 fps)
(VGA VGA (640X480)

i

Slow Motion (432x240(QVGA))

Photo Resolution

A 16MP
5MP
3MP
a Dual Record (The image resolution captured during videos recording
is the same as the video resolution.)
00: 05 . 30 Video playback time counter.
(2)
0003/0008 Current number/ Total number of photo/video.
=
(3) Volume
Return
(4)
ﬁ Video stop
(5) ﬁ Previous video/photo
(6) ﬁ Video fast rewind

22
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Video play

(7)

Video pause

Video fast forward

(8)

OeeBEEEE

(9) Next video/photo
(10) Delete
Slideshow
(11)
Slideshow stop
(12) Magnification Indicator

Operations for Playback Mode

The Playback Mode is for viewing and managing videos and photos on the built-in memory or on an SD
Card.

Operation Display Screen

1. Press [Playback Button] or touch |[BJ| on the screen to | [EEIOGED 71
switch to the Playback mode.

2. Touch to select the specific option.
3. Touch (=1 to back to Record Mode.

23



Video Playback

Operation

Display Screen

In the Video Playback mode, touch ﬁ/ to play
or pause the videos.

Sweep to the right or touch i< to go to the previous
video; sweep to the left or touch to go to the next
video.

While playing videos, touch KN /X5 fast rewind/
forward.

Touch to increase the volume; touch to

reduce the volume.
Touch (=l ) to exit.

I 00:05:50

000370005}

14 < » »p 4 m

Note

» When the LCD is idle for a few seconds, the playback function icons will disappear

automatically.

Delete Videos

screen will appear; touch [Yes] to execute the operation
and [No] to cancel the operation.

Operation Display Screen
1. Touch HEM 1ty go to the Delete option screen. I8 00:05:50
T2 (1< [« [ > [»» »1 [T
2. Touch [Yes] to delete the current video or [No] to cancel (11D [00505%30)
the operation and to exit; touch [All (Delete All)] to
. Delete ?
delete all videos.
3. Before all videos are about to be deleted, a confirmation Yes  All No

T8 C0:05:80

Delete All ?

Yes No

0003/0005]

Note

» Ifa memory card has been inserted, you can only delete those videos stored on the card.

» Videos on a written-protected memory card cannot be deleted.

24
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Photo Playback

Operation

Display Screen

In the Photo Playback mode, sweep to the right or touch
XN to go to the previous photo; sweep to the left or
touch M to go to the next photo.

While the photo is selected, press [Tele Button] to magnify.
(The magnification Indicator appears on the screen)

To navigate the magnified photo, press on the screen and
move as well. (The inner Magnification Indicator turns
red)

Press [Wide Button] to zoom out or exit the magnification
mode.

Touch /M to start or to stop the slide show.
Touch (=M ) to exit.

000B/0005

Note

» When the LCD is idle for a few seconds, the playback function icons will disappear

automatically.

Delete Photo

Operation

Display Screen

1.

Touch HE {5 go to the Delete option screen.

£33 00080005

2 1< »1 o7

Touch [Yes] to delete the current photo or [No] to cancel
the operation and to exit; touch [All (Delete All)] to delete
all photos.

Before all photos are deleted, a confirmation screen will
appear; touch [Yes] to execute the operation and [No] to
cancel the operation.

0O0B/0005

Delete ?

00OB/0005

Delete All ?

Yes No

Note

» Ifa memory card has been inserted, you can only delete those photos stored on the card.

* Photos on a written-protected memory card cannot be deleted.

25
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Section 5
Setting Your Camera

Setting Menu

Operation Display Screen

1. Touch on the screen in Record Mode. The menu
will show on the screen.

2. Touch the [Setting] icon on the screen. Submenu of
Setting will pop out on the screen.

3. The Setting submenu contains 7 options for configuring
your camera setup. They are Sound (operation sound),
TV, Language, Time Setting, Date Printing, Format, and
Default Setting.

Sound

Enable or disable the keypad tone and the operation sound.

Operation Display Screen
1. In the Setting menu, touch the [Sound] icon on the Sound
screen.
2. Touch to select [Off] or [On] ( x)). .
Touch the Exit icon (|[_R#l ) to exit.

TV

Ensure that the appropriate TV standard of your area is selected — either NTSC or PAL. Wrong TV
system setting may cause image flickers.

* NTSC(60Hz):USA, Canada, Japan, South Korea and Taiwan, etc.
» PAL(50Hz):UK, Europe, China, Australia, Singapore and Hong Kong, etc.

Operation Display Screen

1. In the Setting menu, touch the [TV] icon on the screen.

2. Touch to select [PAL] or [NTSC].
3. Touch the Exit icon (| R ) to exit.

26



Language

Use this option to select the language of the user interface.

Operation

Display Screen

In the Setting menu, touch the [Language] icon on the
screen.

Touch to select the desired option.
Touch the Exit icon (| B ) to exit.

e Deutsch

= kN
TN
o il

Time Setting

Operation

Display Screen

2
3
4.
5

In the Setting menu, touch the [Time Setting] icon on the
screen to enter the time setting screen.

Touch Year, Month, Day, Hour, Minute, and AM/PM to set.
Adjust the numeric value by touching . / .
Touch the [OK] icon to validate the setting.

Touch the Exit icon ( ) to exit.

Date Printing

Imprint the date and time on the video and photo.

Operation

Display Screen

In the Setting menu, touch the [Date Printing] icon on the
screen.

Touch to select [Off] or [On] ( CX).
Touch the Exit icon ( ) to exit.

Date Printing
4
EEE®

Note

» Date Printing function can not be used when Slow Motion function is activated.

27
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Format

* Yes: Format the built-in memory ( When there is no SD card in the camera ) / SD Card (When there
is an SD card in the camera).

* No: Do not format the built-in memory ( When there is no SD card in the camera ) / SD Card (When
there is an SD card in the camera).

Operation Display Screen

Format
¢
|

3. Touch the [Yes ] icon to execute the operation and Confirm?

the [No ] icon to cancel the operation.

1. In the Setting menu, touch the [Format] icon on the
screen.

2. Touch to select [Yes] or [No] ( (@D X3 ).

(Touch [Yes] to enter the confirmation screen.)

~'+. Note
’) All the data will be erased if the SD card is formatted. Make sure all the data are copied to your
PC before formatting the SD card.

Default Setting

To restore the default factory setting, select this option.

Operation Display Screen

1. In the Setting menu, touch the [Default Setting] icon on Default setting

~ag]
the screen. .

2. Touch to select [Yes] or [No] ( X ).
(Touch [Yes] to enter the confirmation screen.)

3. Touch the [Yes ] icon to execute the operation and Confirm?

the [No ] icon to cancel the operation. I
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The following table indicates the camera’s default settings

Setting Default Factory Setting
Resolution FHD (1080p 30) for Video
5MP for Photo
Stabilization Off
Motion Detection Off
Slow Motion Off
Time Lapse Off
Self-Timer Off
Smile Detection Off
ISO Auto
Scene Auto
White Balance Auto
Face Tracking Off
Flash Off
Sound On
TV Depends on shipping area
Language Depends on shipping area
Date Printing Off
Volume Level 6
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Section 6
Viewing Photos and Videos on TV

Connecting to a High-Definition 16:9(Wide) TV

1. Connect the HDMI cable to your camera’s HDMI Out port.
2. Connect the other end of the cable to a television.
3. Set the video input source of your TV to “ HDMI.”

4. The steps for viewing stored videos and photos on HDTV are exactly the same as for viewing them
on the LCD monitor.

HD TV

AV-Mode T
(16:9)

"=

\‘n\’—'
II

Connecting to a non-high-definition 4:3 TV

1. Connect one end of the AV cable to your camera’s AV out port.
2. Connect the other end of the cable to a television.

3. The steps for viewing stored videos and photos on TV are exactly the same as for viewing them on
the LCD monitor.

EN
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Section 7
Viewing Video & Photo on PC

Installing Bundled Software

The CD-ROM supplied with this camera contains 2 pieces of software.

* ArcSoft Medialmpression is a user-friendly application that helps you managing your media, burning
your video into DVD, and uploading your files to the web sites easily.

* Adobe Reader is a popular program that you need to have installed to read the User’s Manual. Many
computer users will find they already have this software installed on their computer.

To install the bundled software:
1. Insert the CD-ROM into your computer’s CD-ROM drive. The autorun screen appears.

2. Click “Install ArcSoft Medialmpression”. Follow the on-screen instructions to complete the
installation.

Note

» The detailed Instructions for the bundled software can be found within the program once
the installation is completed. Click on [Extras] on the title bar and select [Help] to open the
instruction manual.

.y/

» Install the bundled software application, ArcSoft Medialmpression, for viewing the videos
correctly on a PC.

Transferring Photos or Videos to a Computer

You can transfer photos or videos stored on your camera to a computer and send them in e-mails to
friends or post them on the web sites.

To do this you should:
1. Connect the computer and camera with the supplied mini USB 2.0 cable. .

2. The videos and photos can be found on your computer at “My Computer\Removable Disk\
DCIM\100MEDIA”. (Under the circumstances of within the SD card in the camera)

3. Under this folder, you can view, delete, move, or copy any video/photo you want.
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Uploading

Section 8
Files to Internet

The built-in Internet Direct application offers you an easy way to upload your files to Internet instantly.

It helps you share them with your family and friends on the web site.

To upload files to Internet:
1.

Connect the camera to your computer by using the supplied USB cable.

2. After making a USB connection, the AutoPlay window will appear. (It may be different based on OS
recognition. If the AutoPlay window does not appear. Please click [My Computer]-->[DVAP]-->[DVAP.

exe] to execute the application.)

DVAP {L:)

Thiz digk or device contains more than one type of
cantent.

What do you want Windows to do?

- Prirt the pictures
g2 Lizing Phota Printing ‘wizard

5

& Copy pictures to a falder on my computer
= uzing Microzoft Scanner and Camera ‘wizard

“Wiew a slideshow of the images
uzing Windows Picture and Faux Viewer

s Open faolder to view files
_.J uzing ‘Windows E=plorer

[\ R

B

!

L OF. ] [ Cancel

(In Windows XP)
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3. The main screen appears automatically on the desktop. (To view the recorded clips on Internet Direct,
it is necessary to install ArcSoft Medialmpression first. )

Note

* The web site may be not allowed to access in certain regions.

4. On the thumbnail screen, click on the up/down icon to change the pages. Click on the file(s) you
want to upload.
5. Click on “ UPLOAD" to start uploading.

Name : IMAGODDD1.AVI
Image Size : 1280%720
File Size : 5,163,388 byte:
Length : 00 : 00 : 9.21

Estimate Upload Time
00:01:43.00
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6. Click on “ CANCEL” to stop uploading.

‘¥internet Direct

CANCEL

Name : IMAGOOD1.AV|
Image Size : 1280%720
File Size : 5,163,388 byte:
Length : 00 : 00 : 9.21

Estimate Upload Time
00:01:43.00

To playback the video file:

1. Double click on the video clip on the thumbnail screen.

2. Click on the Play/Pause icon .“I to play/pause. Click on the Return icon to return to the
thumbnail preview screen.

Name : IMAGDOO1.AV]
Image Size : 1280*720
File Size : 5,163,388 byte:
Length: 00 :00: 9.21

Estimate Upload Time
00:01: 43.00

To setup your account information for the website:

1. Click on E to go to the setup screen.

2. Fill in your account information in the blanks. Then click on “Save”.

User Mame |

Passward |

Broadeast Option & pyblic 7 Private

(If you do not have a account, please sign up on the website first.)
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Section 9

Specifications and System Requirements

Specification

Image sensor
Operation modes
Lens

Focus range

Zoom
Shutter
LCD monitor

Storage media

Image resolution

Video resolution

White balance
ISO

Self-timer
Flash

File format

Image play
PC interface
TV out
Battery
Dimension

Weight

5 Mega pixel CMOS sensor

Video record, Photo record

Auto Focus Lens (F3.5)

Macro Mode:1cm~120cm

Normal Mode: 1 cm ~ infinite

1X~2700X (23X Optical zoom and 120X Digital zoom)
Electronic

3” touch LCD (16:9)

Built-in 128MB memory (partial memory is used for firmware code and software);
SD/SDHC/SDXC card slot support (up to 64GB)
High 4608 x 3456 (16M pixels) (Interpolated)
Standard 2592x1944 (5M pixels)

Low 2048x1536 (3M pixels)

FHD (1080p 30) 1920X1080(30fps)

HD+ (720p 60) 1280X720(60fps)

HD (720p 30) 1280X720(30fps)

VGA (640X480) 640X480(30fps)

Auto/Manual (Daylight, Fluorescent, Tungsten)
Auto/800/1600/3200/6400

10 seconds delay

Flash Auto/Red-Eye-Reduction/Flash Off

Photo: JPG

Video: AVI

Single image/Slideshow

Mini USB 2.0 port

NTSC/PAL selectable, HDMI

Lithium-ion rechargeable battery

126mm (L) x 57mm (H) x 60mm (W)

340g ( without battery)
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System requirements

Microsoft Windows XP/Vista/7
Intel Pentium 4, 2.4 GHz or above
512 MB RAM

1 GB free HDD space

Available USB port

CD-ROM Drive

16-bit Color Display

Note
The LCD screen is manufactured using extremely high-precision technology, so over 99.99% of

the pixels are operational for effective use. However, some tiny black and/or bright dots (white,
red, blue or green) may appear on the LCD screen. These dots are a normal result of the
manufacturing process, and do not affect the recording.
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Section 10
Troubleshooting

Troubleshooting

1. The flash is not working.
The battery power is low.
The camera is in DC power mode.

In flash auto mode, camera flash fires ONLY when necessary (in dark setting as example).

2. The files on the memory card do not display smoothly when the LCD shows the “!” marking.
The “!” means the SD card is low speed or is having wrong content inside. The way to solve this
condition is to format SD card by the camera instead of a PC (Please refer to the detailed Format
instruction in Section 5).

Or please change the SD/SDHC/SDXC card to a high speed one.

3. Why do some of my indoor photos look blurry and dark?
The camera extends photo exposure time under low light/ indoor condition. Keep the camera (and

the target subject) steady for several seconds when taking photos. The shutter will sound when
photos are being taken.

4. How do I charge battery?
You must use the supplied AC charger or the USB cable. The camera must be turned OFF. The
blinking light confirms the camera is currently charging, and the light becomes constant after the
charging is completed. In AC charging Mode, the light will turn itself off automatically after 3~5
minutes . The full charge time is about 4 to 5 hours. (Actual charging time may vary. It depends on
the battery conditions.)

5. After connecting the USB cable to the computer, ......
1. The disk [DV] indicates the internal memory of the camera. (The disk label may be different
according to different model and PC OS.)
2. [Removable Disk] indicates the external memory. (Under the circumstances of within the SD/
SDHC/SDXC card in the camera)

3. The disk [DVAP] indicates the built-in Internet Direct application is saved at this disk. Please DO
NOT format this disk or delete the application inside; otherwise, the Internet Direct application
can not function.
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